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Introduction SKSS

The Silent Knight Software Suite (SKSS) isatool for communicating with the IntelliKnight
5820X L, 5808, SK-5208 fire panels and the 5000-Series entry systems. This software makesit is
easy to program panelsfrom aremote location, like the central station service center or locally when
directly connected to the panel. SKSS allows you to upload (receive) datafrom a panel to aPC. For
example, you can upload event history from a panel so that the history can be sorted and viewed on
screen or printed as areport. Y ou can also upload programming changes that have been made at the
installation siteto a PC.

Features

» Compatible with IntelliKnight 5820XL, 5808, SK-5208 fire panels and the 5000-Series entry
systems

* Easily program panels from aremote location or on-site

 Upload panel account information to your PC

 Quick access to panel event history

« Upload detector status from the 5820XL, 5808

 Forward and backward compatible with panel software

» Reducethetimeit takes to reprogram an upgraded panel with the built-in Translate option

* Free software upgrades downloadable from the Silent Knight web site (www.silentknight.com)

About This Manual

This manual will help you get started using SKSS and is future reference for operations that you
don't frequently perform. The menus and screens in the software are your main source of
information for the more commonly performed operations. Y ou can also get help from the
software’ s comprehensive online help system by pressing the [F1] key at any time (not available
during beta testing). For information on general concepts such as, mapping and points, that appear
in SKSS programming views, refer to the panel’ s Installation and Operation Manual.

System Requirements

To operate SK SS software you must have a PC with Windows® 95/98/2000/ME or Windows NT®.
Y our system should also have the following:

16 megabytes RAM
» 8 megabytes of free hard disk space
* VGA color or compatible monitor

+ A Bell 212A/103 Hayes® compatible Plug and Play modem to connect to remote panels. Y ou can
also connect the FACP directly to the PC, when onsite, using the 9-pin serial cable.
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Mouse Versus Keyboard

SKSSisdesigned to be used with a mouse. Using a mouse is the fastest and easiest way to
operate the software. However, amouse is not a requirement; all operations can be performed
from the keyboard. See your Windows documentation for information on navigating in a
Windows environment.

Online Help

Y ou can press the [F1] key when you have SK'SS running to bring up the online help system
(not available during beta testing). The help screens describe each data entry area on the view
and explain how to select options.

Backing Up Your Data

Protect your valuable data by frequently backing up files using the backup tool of your choice.
Files with extensions .[ Panel Type] Account, .[ Panel Type] History and .[ Panel Type] Detector
contain your data. For example, afile with the extension .5820Account contains the account
information on a5820X L panel and afile with the extension .5080History contains the history
information from a 5080 panel. Back up these files whenever you make changes. (See Table 1
on page 9 for more information about types of files and extensions.).

Technical Support

Silent Knight provides 7/24 technical support from our Web site at www.silentknight.com. Print
installation and operations manuals, get answers to frequently asked questions, download the
latest software revisions, e-mail questions to technical support are just afew of the things you
can do on our Web site. Silent Knight also offers free technical support.

How to Reach Us
Web site:
www.silentknight.com

Technical support:
Monday - Friday, 8:00 AM to 6:00 PM
800-328-0103
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Installing SKSS

SKSS walks you through the installation process and can be installed and configured to work
with Silent Knight control panels in less than ten minutes.

Installing SKSS

If you are anew user of Silent Knight software, go to the installation procedure below. If you
have aversion of Silent Knight's SK Analog Fire System Editor installed on your PC, the new
software will not overwrite the directory or accounts you' ve already set up. Once you've
installed SK'SS, you will need to upload information from each panel to populate the software
with your existing accounts. The files created in SK Analog Fire System Editor are not
compatible with SKSS.

Toinstall SKSS:
1. Place SKS Software Disk 1 in your PC's A> drive.

2. From the Windows Start menu, select Control Panel, then double click on Add/Remove Programs.
3. Click on Install, then Next.
Follow the instructions on the screen for continuing. During installation, the program will ask you
where you want to store the software. The default is c:\ProgramFiles\SK'SS. You can click or press
[Enter] to select the default or type in another location.

Note: CD Key can be located on the inside of this manual’s the front cover.

If an error occurs during installation, make sure you have sufficient memory and disk
space on your PC (see page 1). If you have sufficient system resources and the software
still will not install or run, contact Silent Knight Technical Support at 800-328-0103.
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Starting SKSS

1. From Start, select Programs, Silent Knight and then click on Silent Knight Software Suite.
The login dialog box appears.

This proaram is password protected
Flease enter your user name and password to contine.
Login Infarmation

Username: | N -
Password

N

When logging on for the first time, select Master from the User Name dropdown list.

Press Tab to move to the Password text box and enter pass.

4. Click OK. The SKSSwindow appears.

Note: If you've used the SK Analog Fire System Editor, note that the Communications Queue is no
longer a separate application. The Communications Queue is integrated into SK'SS as shown below.

w

SKSS - [O] x]

File Yiew Optio

DEm=|HWeHE2 SR

* | aceount | Tranzaction | File Mame | Call Type | Statuz | Mext Call Time I Lazt Call Tirme I FPhorne Mumber

[ |2
/ For Help, press F1 W aiting MUk él

1formation on
ommunications
etween the panel
nd the PC will
ppear here.
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Using Password Protection

Through the password system, you can make surethat only qualified usershave accessto SKSS.
Or, if you prefer, you can disable password protection so that anyone in your facility can have
accessto SKSS.

Initial Password

SKSS comes with a Master User and Password. When logging on for the first time, select
Master for the user and enter pass asthe password. Y ou can then change the password, add new
users or disable password protection.

Adding/Editing/Deleting Users and Passwords
Y ou can add up to 100 usersto SKSS, in addition to the Master User. All users can perform all
software operations. The Master User cannot be del eted.

Toadd auser:

1. From the Options menu, select
Users & Passwords.

2. From the Users and passwords dialog
box, click on Add User.

3. Enter up to 20 alphanumeric
characters for the user and 20
alphanumeric charactersfor the user’s

*[Rccouwn | Tinssction | FieHame | CalTige | Sostus | Hewt Col Toe | Lo Col Tme | Prvone Humber
password.
4' Cl ICk OK N r‘.y‘uL e ard Passrmcards ot HUM : ’,!
Todeletea user:

1. From the Options menu, select
Users & Passwords.

2. Atthediaog box that displays, select the user you want to delete, then select Delete User.
3. Click OK. The user will be deleted.

Turning Password Protection On/Off
If you don’t want to require users to enter

passwords when they operate the spftware, Click here to disable e v ]
you can permanently disable the dialog box password
for entering a password. protection. =
H Ue'::“:mw frenes .

1. From the Options menu, select Users & -
Passwords. o o st '

2. From the Users and passwords dial og box,
click on the Enable login dialog box check
box to turn protection on or off. If thereisacheck mark in the box password protection is on. If there
isno check mark in the box, password protection is off.
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Setting Up Communications with the Panel

Before you can use SK'SS to communicate with a panel, you must configure a communication
device. To connect to aremote panel, you'll need to use your PC’'s modem. With the all the
FACPsyou can also connect locally with a seria cable.

PC Modem Connection
To communicate with a panel, you will need to have a Hayes® compatible modem installed on
your PC. Follow the instructionsin your PC and modem manuals for connecting a modem to
your PC.

Serial Cable Direct Connection to the FACPs
Thefigure below showsthelocation of the 9-pin connector onthe 5820X L, 5808, 5208 (version
2). Use this connector to attach the serial cable to the panel.

Note: The panel will bein ground fault trouble if you are connected to a PC powered by AC
while the cable is connected. The trouble will clear when you remove the cable when you've
finished communicating with the panel.

B-pin connector
on control board

5820XL Cable Connection assembly

-
- | ol
me L —
e [ b
To computer
senal port

|
15 o
o

1

5208 Cable Connections

Use standard
S-pin serial cable.

To computer| |]|:.| D
serial port 1 o

= §

5808 Cable Connections

Figure 1: Usea 9-pin serial cableto connect a PC running SKSSto a FACP.
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Configuring Communications Between the PC and Panel
To communicate with the panel, you will need to select the PC’'s modem or if connecting
directly to the panel with a serial cable, the com port the serial cable is connected to.

To configure the communications device:
1. Select Options from the menu, then Communications.

Communication Configuration n m

Connect Using:

Line/Port: [{if

% Configure Line... |

Changes made from this dialog are temporary and only in
effect until the application exitz. If permenant changes are
desiried, make the changes from the Control Panel.

ok I Cancel |

2. Select the PC'sinstalled modem for modem communications or the com port the serial cableis
connected to for direct connection to a FACPfrom the Line/Port drop-down list.

Note: When communicating with some panels, communications speed isimproved
by adding the S10=255 AT command. SKSS will automatically check to see that
the S10=255 AT command is set in the Windows Advanced Connections
Setting of your modem when dialing certain panels. If not, SKSS will attempt to
send the command. To configure the modem with this command, see the following

paragraph.

Adding/Removing the S10=255 AT Command Setting

The S10=255 AT command ensures the most efficient operation for modem to panel
communications. This command will improve communication speed between the modem and
the 5820X L, version 4 and lower panels, 5080 and 5208 panels.

The S10=255 setting may not be useful for other communications applications. During these
times you can disable the S10=255 AT command. The next time you use SKSS, you will be
reminded that the S10=255 command is not set.
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To add the S10=255 AT Command Setting:

1.

2.

3.

Click on Configure Line in the Communication Configuration dialog box.

Communication Configuration n ﬂ

Connect Using:

Line/Part: IMu\tiTech Systems MTEE00Z0MW j

Changes made from this dialog are temporany and only in
effect until the application exits. If permenant changes are
desitied, make the changes fram the Control Panel

ok | Cancel |

Click on the Connection tab, then Advanced from the modem settings dialog box.

MultiTech Systems MTS600ZDXV Properties [ 7] x|

General | Connection | Dptionsl Addressl Forwardingl

r Connection preference:

Data s ARG
Parity: I Mone - l
Stop bits: I‘I VI

r Call preference:
[V Wit for dial tone before dialing

¥ Cancel the call if not conmected within IBU secs

[ Discornect a callif idle for mare than I minzs

Advanced... |
ok I Cancel |

Type S10=255 in the Extra settings text box.

Toremovethe S10=255 AT Command Setting:

1

g ks wDN

Click on the Windows Start button, then Settings, and finally Control Panel.

Double click on Modems. The Modems Properties dialog box appears.
Select the modem from the modem list and click on Properties.
Click on the Connection tab, then Advanced.

Delete S10=255 in the Extra settings text box and click OK.
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SKSS File Types and Naming Conventions

SKSS has three file types. Each file type stores different information about a specific panel or
account. Filetypes are identified by their file extension as shown in the table below. When you
are working with the files, a unique icon will display in the upper |eft corner.

Table 1: Types of Files

Icon File Type Contains Extension Pandls
. Account Viewsfor programminga | .[Panel No.JAccount | All
S

panel and other account

information.

e Event Eventsthat occurred at the | .[Panel No.JHistory All

EE History panedl. Thisfiletypeis
uploaded from the pandl.

= Detector Status of detectors. This .[Panel No.]Detector | 5820XL,

Status file typeis uploaded from 5808
the panel.
File Menu

The file menu contains optionsthat apply to al Windows applications (such as Open, Save, and
Save As), aswell as some options that are unique to SKSS. The chart below describes SKSS
specific options.

Table 2: File Menu Options

Option Description

New Select New to create a new account file for uploading and/or downloading panel
programming information.

Open Account Open an account file that is aready stored on the PC.

Open Event Open an event history file that has been uploaded from a panel to the PC.
History

Open Detector Open adetector statusfile that has been uploaded from apanel. Thisoptionisfor
Satus 5820XL Rev. 1.2 and |ater, and 5808 panels.
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Table 2: File Menu Options

Option Description

Trandate When there is more than one version of panel software, you can use the Trand ate
feature to save programming time when upgrading a panel to a newer version of
software. The new (trandlated) version of the account provides access to new
programming options and previous programming will not be overwritten when
you configure the new options.
When you open an account, the Panel version number appears on the Account
Info view. The trandate option is available only if the account is not already
saved in the latest version. if you create a new account or open an account that is
already in the latest version, the Translate option will be dimmed on the menu.
1. FromtheFile Menu, select Trandlate.
2. Click on OK in the Message Translated dialog box.
3. Savethe account or use the Save Asto save the old and new file.

Upload Upload an account from a panel. (Data stored at the pand is sent to the PC.)

Account

Download Download an account to a panel. (Data store on the PC is sent to the panel.)

Account

Upload Event Upload event history from the 5820X L, 5808 or 5208 panel to the PC. Once the

History event history has been uploaded it can be viewed on screen and printed.

Upload Upload detector status from the 5820X L, 5808 panel to the PC.

Detector Status

Upload Clock You may never need to use this feature, but if you ever need to upload the clock
setting from a FACP, this command allows you to do so. Thisfeatureis primarily
for troubleshooting and verifying that the panel is operating properly. If the
system clock should ever reset, you or Silent Knight technical support staff may
want to know the current time at the panel.

Download This feature synchronizes a FACP clock with the PC's current time setting. This

Clock feature is only used for panels connected to viaa modem.

Print You can print any of the file types from SK'SS. When the file you want a report

fromis open, select Print from the File Menu. Prior to printing you can select
Print Preview from the File menu to view the report onscreen.

10

P/N 151240




User Manual

Programming

The programming views for the different panels are briefly discussed below. For complete
information about the individual fields (or data entry areas), refer to the online help (not
available in the beta version). For an overview of basic concepts about a panel refer to the
panel’s Installation and Operation Manual.

Views for the 5820XL, 5808 Panel

The figure below shows the General Parameters view, the view (or screen) for programming
options that affect the general operation of the panel. Table 3 describes the purpose of each
programming view for the FACPs.

SKSS - IFP10001 =1 E3

D@ d B &R
Accourt Info, General Paarns. | Disler | System | Input Zones | Dutpus Groups | Templates | Mapping | Output Pattern | User Profies |

|~ Panel Codes \Wiater Flow Dielay - | - Dlock Source [Power Line Freq] | =
‘ Satende |1 ‘:6‘ BOHz(" 50Hz C Intemal ‘
Giobalepetng Opbors | Evert Dy --‘

LowAC I Aulo Display Oldest Event
Conputer: [T Rence Dty [° L

| R R — !--Sm:mnﬁuﬂy

| Dayight Savings Time | Riapart Events [by Zane -| I~ Enable day/night sensitivity
IV Auto DST adustments - -

-o— [~ System Alarrn Output Pattem | | Day Start:

+ Display Clock

Firecril
5 " 0500 P
© AMPM ) Miitasy [CortamtOn =] | | NohtStat [0600PH_|

5 Aux 1 >
Custom Banner... m Sensitivity Days..
System Aux 2 Senitivity Holdays. .
Constant On fd

1]

X [ Account [ Transaction | File Name [ Call Type [ Status [ Nest Call Time [ Lasl
I K5 I |
For Help, press F1 [Wating | [NUM 7

Figure 2: General ParametersView for Panel Programming.
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Table 3: Programming Views for the 5820XL, and 5808

View Name Use This View To

Account Info. Program subscriber data, including account phone number, contact
person name.

Genera Params. Program options that affect general operation of the software, including
system clock options.

Dider Change options for the dialer. This includes such options as account
number, reporting format, and other options related to reporting to a
central station.

System Add and delete modules and select options for input and output points.

Input Zones Add, delete or modify options for input zones.

Output Groups Select options for output groups, including adding and deleting groups.

Templates When a5820X L, 5808 installation requires that zones be mapped to

more than 8 output groups, you can use templates. With output group
templates you can combine one or all output groupsinto one template,
which can be used when the same combination of outputs are used for

several zones.

Mapping Assign output groups to zones.

Output Pattern Create customized output patterns, patterns that sounding devices (or
other output devices) will use.

User Profiles Create custom up to 20 users code with customized profilesfor each
user.

12 P/N 151240
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The Zones screen below is one of several screens used to set programming options for the

SK-5208.
SKSS - 52081 M[=1E3
e Yen Opbons Windw Hep
DEEe d wede SR
Zones | HAC/Relay | NAC Dutpet Pattens | Diser | biscetansons | Expandes |
ik pone oo |Teml  vensn [ [ |Mime| wo | Ao | cow 14
1 Fore e = = | Hore - ¥ = ¥ Clazs & =
F :ml E“ E: ELme = o= ) ] cuL;.--.-: =l
3 [Zane 3 Fie = L E H a 1 E
4 |Zored Fira =h = |Hore E = i ¥
5 [Zone5 Fie = X|Nore 5 = i 1
6 |Zore b Fre =h x| Moew H = = M
7 |Zore? Fire = F|Nore E = = o
A (ZoraBd Fue = X|Nore hd ¥ | ] | 8]
3 |Zoned Fie =h i ¥ = = ]
10 |Zore 10 Fae =h = | Hone = = a2 ¥
11 (Zane 11 Fite = FlNore = = i o
12 [Zone12 Fig = =|Hone H = = o
13 [Zone 13 Fue =l X |Nore H = I | ¥
14 |Zone 14 Fue = = |More = = I ]
15 |Zone 15 Fie =h = [Nore * = S | o
16 [Zone 16 Fire = I 7 = al o |
4 l‘ = = = B = . 2 I »
* [ Accownt [ Transaction File: Name CalT, Stalus [ Mewt Cal Tire | Last Call Time | Pione Huribe
3] |
Foe Heb pross F1 Watrg | UM -
Figure 3: Zones View for Panel Programming
Table 4: Programming Views for the SK-5208
View Name Use This View To

Zones Add, delete or modify zones.

NAC/Relay Establish or modify zone NAC/output patterns such as silence, fire,
prealarm, etc.

NAC/Output Patterns Create custom output patterns for sounding devices and other output
devices.

Dider Change options for the diaer. Thisincludes such options as account
number, reporting format, and other options related to reporting to a
central station.

Miscellaneous Add and modify 3 to 6 digit installer and operator user codes, alarm
responses, such as NAC automatic silence time and prealarm time, and
banner display settings.

Expander Select options for output groups, including adding and deleting groups.
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Views for the 5000-Series
The System screen is one of three screens used for the 5000-Series panels used to set general

programming data, including system message, clock format and installer code.

Fie Vew Qpiors Wndan Hep |
ﬁﬁaﬂ&' HwenEo .

E
Mlu»«: | e o |
Sytam Meztage Diaing lomeat Access lIratabers) Code
- 7 Touch Tone 123456
1 Pulsa - Urited States | 040
~ Clock: format T Pubse - Euopeen | £5:34 ) Computes Accourt Number
12 How [ooEoen
% 24 How P Husmber
I™ Hide sccess cods 173456
™ Diskng * Eutton before &
UsecHimberlongth' =1 oo Draist Commputes Phone Murber
4 a
- Cal lengthlsecond:)
L = Parel Moelession
Spesker Vokume Aot fings | —
Low bod 3
Do trsfeaconds]
ol 3
* [(ccourt | Tranzacton | Fie Name | CaAType | St | Newa Call Time
l
e EE=—e— M
Foe Hep, press F1 wating | NUM | 1

Table 5: Programming Views for the 5000-Series

View Name Use This View To
System Set genera programming data, such as the system message, clock
format and installers code.
Users Program, edit and delete up to 1000 tenants. You can add user namesin
the SK'SS, in addition to numbers. The user names are only stored in the
SK SS and cannot be downloaded to the panel.
Aux. Relay Program and modify auxiliary relay settings.

14
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Scheduling Jobs

The panel and a PC can communicate with each other by downloading (computer sends datato
the panel) and uploading (panel sends data to the computer). This section of the manual
describes communication operations.

The Communications Queue

The Queueisalist of completed and scheduled tasks between panels and SKSS. When a task
appears in the Queue window, its status and other information will display next to the account
number.

K55 - 5020040 1,5820Account
D@ B wadls R

SH2(DA 1. 5820Aecount

Accomtinfe | Geness Pacams. | Diskr | System | s Zomes | Duscus Gioupe | Tompistes | Mageing| s Paiten | User Poties |

Customer Accound 8 e Fanel Type/Netson: er_
e }-\ndev:w'v\'a:hef:

{:c\ﬂ[‘c\e

1‘:3-45&?9‘!}
Cutomer Phone:

{?ss?.leua-.m Parkway

This panel is
connected directly
to the PC so no
phone number

1%:«1\*

appears.

Account | Tearmaction | Fie Narme [CoType [ St 1 et Cal Time ] Last Ca Time 1 |

S0 Deownlosd C:\Program Files Call Orce Aborted by User 10N 34257 P

SE20 Downlosd C\Program Files Cali Orce Watng 10720401 34320 PM

F;Hﬁ‘!
Describes the type File name assigned The status of these This panel is
of job that has been  onthe PC where the jobs is Waiting connected directly
completed or is information is because they have to the PC so no
scheduled to occur.  downloaded from or been scheduled to phone number
uploaded to. happen at a later appears.
time.

Figure 4: Communications Queue Example

Delete Jobs from the Queue
All jobs remain in the queue until you delete them. Y ou can delete jobs that are finished and
jobs that are scheduled.

Todeleteajob from the Queue window:
1. Highlight the job you want to delete by clicking on it.

2. Pressonthe[Delete] key. This action cannot be undone.

P/N 151240 15



Silent Knight Software Suite

Job Status

Jobs or accounts listed in the Queue window are assigned a status. The chart below describes
all possible status types.

Table 6: Queue Job Status

Status Description
Waiting Thejob iswaiting for processing. Another job is currently being processed
or the job istimed to execute at alater time.
Error An error occurred during processing. No data was transferred. See page 22
for more information.
Processing Thejob is currently processing, for example, sending or receiving data.
Complete The job has completed successfully. Completed jobs remain on the queue

until an operator del etes them.

Aborted by User | The job was cancelled during processing by an operator. Aborted by User
jobs remain on the queue until an operator deletes them.

Timed Out The job was not completed because communication was not established
during the programmed timeframe.

Security Not The panel did not answer the call because an incorrect password was used by

Granted the operator who attempted to process the call.

No Carrier or The job was not processed because communication was not established. This

No Diatone message can indicate several problems. See page 22 for more information.

Modem Error The job was not processed because the software detected a problem with the

modem. This message could indicate that modem is not turned on, needs to
beinitialized, or another problem. See page 22 for more information.

Busy Signal The job was not processed because the communication device encountered a
busy signal when attempting to call.

No Answer The job was not processed because the initiating communication device did
not receive an ACK signal.

Detector Status | The detector status feature is not available for Rev. 1.1 panels; Revision 1.2
Not Supported and later support the feature. If you attempt to run the Upload Detector Status
festure with aRev. 1.1 panel, you will receive this message.

16 P/N 151240
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Downloading and Uploading

Y ou can download and upload various options, depending on the panel you are working with,
such as panel programming settings and event history as shown in Table 7. When downloading,
you are sending data (options that have been programmed using the SK'SS programming views)
to the panel. When uploading, you are sending data from the panel to the computer.

Upload: Receive information from the panel.
N 5
7 R REEREEE I I

Download: Send information to the panel.

Table 7: Download and Upload Options by Panel

Option

5820XL

5808

5208

5000-Series

Panel Programming

Event History

Clock Settings

Detector Status*

* The option for uploading detector status that appears on the file menu is available

for Rev. 1.2 and later panels only.

P/N 151240
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To download or upload panel information:

1

From the File Menu, select the download or upload menu item you want to schedule.

File Downluad [ =]

ecount Nuer
Crmpures Code i
Prane Muber

Answering Machine Bypass

I U srmovemry Mt Bypass
Hangrup delay.
Bl dela

0
[F
| Corerd |

2. Intheappropriate locations in the dialog box, enter your selections for the following options:

File Name:

Account Number:

Computer Code:

Phone Number:

Call Option:

Answering:

To download, select thefile that you want to download. To upload
assign anameto thefilethat will be uploaded from the panel. Y ou can
use the Browse option to select from the list of availablefiles. If you
do not select a name for thefile, it will be automatically named with
the panel model and the date and time of the download.

For downloads, the latest saved version of the file will be sent. This
means if the file you want to send is currently open and has been
changed, save it before you attempt to download.

Enter the panel account number.

The default value for each control panel islisted in the installation
manual for that control panels. The box remains blank for a 5000-
Series pandl.

Enter the code that allows access to the panel from a PC. The default
value for each control panel islisted intheinstallation manual for that
control panels.

If you are using a modem for communication, enter the panel phone
number.

Select how often and when the call should be placed.

Select the preferred optionsif the phone line used by the PC’s modem
has an answering machine installed. This feature is not used when
connecting directly to a panel.

3. Click OK to begin downloading/uploading or to post the job to the Queue.
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Working with Event History Data

User Manual

Y ou can upload event history from a 5820XL, 5808 or 5208 panel. When uploading afile from
the panel’ s event history buffer, you will have all of the most recent events that have occurred

at the panel. Not all the events may be of interest to you at any given time. Y ou can use the

software to select only events that meet particular criteria, sort events, print and combine files

of events.

Note: The 5000-Series panels do not store events, so this procedure does not apply to the

5000-Series panels.

1. Once event history has been uploaded, select Open History from the File Menu.

2. Select afileto open. You can scroll through thelist of availablefiles or enter the file namein the File
Name areain the dialog box.
3. Fromthe next dialog box that displays, select options for controlling how the history is displayed on

screen and printed.

Refer to the online help for more details about these options (not available during beta

testing). If you want a printed report of the data, select Print from the File Menu.

Selectorderin which
events display.

display events that
securred during a
specific time.

ielect the types of

vents to display. \

SK55 - [5820 2000-03-07 09h07m51s.IFP1KHistory] [_ o] <]
m File View Options Window Help - Slﬂ
D@ ? | HIVNER SR
Sort Order Ewent History
Sart By: INumbEl d ] Dae | Time | Event |
1 07/01/1995 05:03AM WP Trouble Zone 1 H
 Date Fiter 2/01/1/1995 05:034M  Manual Pull Trouble Zane 001 [M33:P057]
3 01/01/1995 05.03AM  Det Trouble Zone 1
Staing Date | 1/ 185 ] 4.01/01/1935 | 05:03 AM | Photo Det Trouble Zone 001 [M13:P073]
Erding Date: W 5 01/01/1935 0354 AM | MP Trouble Zone 1
6 01/01/1995 0354 AM  Manual Pull Trouble Zone 001 [M23:P057]
*ime Fiter 707/ /1995 N3534M  Det Trauble Zore 1
2 01/01/1995 0253 AM  Photo Det Troubls Zone 001 [M13:P073]
Starting Time: | 1200:00AM = 9/01/071/1995 0328 AM | Gnd Fault Restore Module 05
Ending Time: | 115353 PM =] 10/ 0140141995 03:28AM | Gnd Fault Restore Module 03
- 11/01/01/1995 0204 84 | At Test Channel 1
12 01/01/1956 1202 8 | MP Troubls Zane 1
[ Show Thess Event Types 13/01/01/1935 12024 Manual Pull Trouble Zons 001 [M33P097]
W Alains 14/01/01/1335 12201 AM | Det Trouble Zane 1
I Restares 15 0140141935 1201 AM | Photo Det Trouble Zone 001 [M13:P073]
Fl Troutles 16 01/01/1995 120044 | Gind Fauk Madule 05
W Paint Disable 17/ 01/01/1955 12:004M | Gnd Fault Module 03
[ Test 18010141995 12:004M | System Power Up
! Operator Ressts 19 01/03/19595 0204 & | Auta Test Channel 2
! Local/Unieported 20 01/02/1995 1051 PM | Det Trouble Restore Zone 2
21 01/02/1995 1061 PM | Phota Det Trbl Fist Zane 002 [M13P037]
#ppend History File... 22 0140241935 1051 PM | Photo Det Enabled Zons 002 [M13P037] |
* [ acoount | Tranzaction | File Name | Call Type | Status | Next Call Time
M l | ol

For Help, press F1

[watirg [ [NOM [ | 2

P/N 151240

Figure 5: Event History Window.
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Combining Event History Files (Append History)

The 5820XL, 5808 can store up to 1000 events and 5208 panels can store up to 150 events.
When a panel reachesits 1000 event capacity, it begins deleting events starting with the ol dest.
When you save an upload, you create afile that you can save permanently or for aslong asyou
need it. Y ou can aso append (or add) events from another file so that uploaded event files will
be combined, saving you from having to search through multiplefiles.

For example, suppose a panel reported 1000 events every two weeks, but you wanted to retain
files of events by month. Since the panel would start deleting events as more were added, the

panel’s buffer would never contain an entire month of data. Y ou could compensate for this by
uploading event history twice per month, once for the first half of the month and once for the

second half. Y ou could then Append the events from the second half of the month to thefilefor
the first month. Y our file would then contain events for an entire month.

To add history events from onefile to another:
1. Openthe primary history file by selecting Open Event History from the File Menu.

2. With ahistory file open, click on Append History File.

3. Select thefile that you want to add to the primary history file. You can scroll through the list of
availablefiles or enter the file name in the File Name areain the dialog box. Event history files have
the extension .[ Panel Type] History.

4. Thefile now contains event data from both files. When you save the file, you may want to use the
Save As feature to give the combined file a unique name.
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Detector Status Data

When you upload detector status from an 5820X L, and 5808 panel, you will have afile
containing the status of all detectorsin the system. Not all the detectors may be of interest to
you at any given time. Y ou can use SKSS to select only detectors that meet particular criteria,
such as, detectorsthat are out of compliance or that need maintenance. Y ou can also sort thefile
by various criteria and print the information that you need.

1. Once detector status has been uploaded, select Open Detector Status from the File Menu.

2. Select afileto open. You can scroll through thelist of availablefiles or enter the file namein the File

Name areain the dialog box. Detector status files have the extension:
[Pand Type] Detector.

3. The Detector Status View will display. Select options for controlling how the detector statusis
displayed on screen and printed. A dialog box similar to the one below will display. Refer to the
options on the help screen for complete information about how to select these options. If you want a
printed report of the data, select Print from the File Menu.

SKSS - [5820 2000-03-07 09h08m26s.IFP1KDetector] - [=] x]
& File View Options Window Help — 18]l

D@2 HIWVNES SR/
Show Paint Compliance
[V “Yes: within NFP&, 72
V! Mo: out of NFP&, 72

Detector Status

Show Point Status
¥ Hormal

¥ Calib. Mairtenance
[¥l Calib. Trauble
¥ Other troubles

Sort Order——————— ~ Show Faint Types
Sort By: lm [V Phato Detector
¥ lor Detector
¥ Heat Detector
¥ Photo Duct Det.
¥ lor Duct Det.
V! Sup. Photo Duct Det.

V! Sup. lon Duct Det.

0| Marme | Twpe [Znlsen|at|ac|mr]rr]calcalrcral  sStaus  [NFPai-]
07001 TWENTY CHARACTER NAM Photo 35 245 83 %4 &1 24 G124 Nomal ez —
07002, TWENTY CHARACTER NAM Photo 35 245 83 9 B3 25 64 26 Nomal Yes
07:003 TWENTY CHARACTER NAM Photo 35 245 83 9 B2 25 63 25 Nomal Yes

1 a

2 a

3 a
07:004 TWENTY CHARACTER NaM Phaoto 4 35/ 245 0 83 94 B 24 B2 25 Nomal ‘ez
07:008 TWENTY CHARACTER NaM Phaoto 5 35/ 245 0 83 94 B 24 B2 25 Nomal ‘ez
07:006 TWENTY CHARACTER NaM Phaoto B 35/ 245 0 83 94 B2 25 B3 25 Nomal ‘ez
07:007 TWENTY CHARACTER NaM Photo 7 35/245 0 83 94 B2 25 B3 25 Nomal ‘ez
07:008 TWENTY CHARACTER NaM Phaoto 8 35/ 245 0 83 94 B3 25 B4 26 Nomal ‘ez
07:009 TWENTY CHARACTER NaM Photo 9 35/245 0 83 94 B 24 B2 25 Nomal ‘ez
07:010 TWENTY CHARACTER NaM Phaoto 10 35 245 0 83 94 62 25 B3 25 Nomal ‘ez
07:011 TWENTY CHARACTER NaM Phaoto 11 35 2458 0 83 94 B 24 B2 25 Nomal ‘ez
07:012 TWENTY CHARACTER NaM Photo 12 35 245 0 83 94 62 25 B3 25 Nomal ‘ez
07:013 TWENTY CHARACTER NaM Photo 13 35 2458 0 83 94 B 24 B2 25 Nomal Yes
* | aceount | Tranzaction | File Mame | Call Type | Statuz | Mext Call Time

<] | o]

For Help, press F1 W aiting l_ MUk él

Figure 6: Detector Status Dialog Box
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Communication Error Messages

The chart below describes communication error messages that could occur during processing.

These messagesindicate that transfer of datadid not occur. If you receive one of these messages
and do not know what caused it, see Troubleshooting Communications problems below. If the
problem persists, contact Silent Knight Technical Support.

Table 8: Communication Error Messages

Message Explanation

Error An error occurred during processing of the call. No datawas transferred. This
message can indicate awide variety of problems, including a problem with the
modem or noise on the telephone lines.

Timed Out Thejob was not completed because communication was not established during the
programmed timeframe.

No Carrier The job was not completed because the communication device could not establish
communication.

Modem Error The job was not completed because the software detected a problem with the
modem. Make sure the modem isturned on. Try reinitializing the modem.

Busy Signal The communi cation device encountered a busy signal when attempting to
communication. Try again later.

No Answer The communication device did not receive an ACK signdl.

No Diatone A diatone could not be detected by the communication device. Check that the
receiving deviceisturned on and is connected to the phone line.

Troubleshooting Communication Problems

Troubl eshooting communication problems can be complex because the problem could be at
either end of the connection. If communication did not occur or was incomplete, here are some
thingsto try.

When using a modem, make sure the communication device is connected to the phone line and
that dial toneis present. If you suspect that noise on the telephone line is causing a problem, try
any or all of the following:

» Hang up and try again.

« Initialize hardware. Thiswill happen any time you close the queue and reopen it. Y ou may
need to reset the modem, especialy if you receive the “Modem Error” message.
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